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1 Installation
The Maya FBX plug-in is used by Maya to import, export, and convert 
files using the.fbx file format. This chapter describes how to install the 
Maya FBX plug-in on Windows®, Mac® OS X, and Linux systems.

The Maya FBX plug-in comes with Maya and is installed automatically. 
This procedure is included so you can upgrade your Maya FBX plug-in 
with later versions.

Windows installation
The Maya FBX plug-in is available for Windows 2000 and Windows XP. 

To install the Maya FBX plug-in:

1 Download the install file from the Autodesk web site (http://
www.Autodesk.com).

Important Plug-ins run only on the version of Maya for which 
they are created so you should verify that the 
version of the Maya FBX plug-in that you are 
installing is appropriate for the version of Maya 
you are running. Maya rejects plug-ins created for 
different versions.
Maya FBX Plug-in Guide
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1 | Installation
Windows installation
2 Double-click the install file to launch the Autodesk plug-in installer 
(figure 1-1).

3 Click I accept to accept the terms of the license agreement, and 
then click Next.

4 The next window shows the recommended installation location for 
the plug-in (figure 1-2). To specify another location, click Browse to 
launch the file browser so you can select a new location. Click 
Next. 

figure 1-1: Autodesk Installer 
window

figure 1-2: Autodesk 
Destination folder window.
Maya FBX Plug-in Guide
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1 | Installation

Macintosh installation
5 The next window shows the recommended installation location for 
the plug-in documentation. To specify another location, click 
Browse to launch the file browser. Click Next

6 A series of dialog boxes appear asking if you would like to keep 
older versions of the plug-in (if applicable), see the readme, and 
view the plug-in documentation. Select Yes or No for each of the 
options.

7 The installation completed window appears. Click Close to exit the 
installer.

The Maya FBX plug-in is now installed.

8 Start Maya and navigate to Window > Settings/Preferences > Plug-
in Manager.

9 Activate the Loaded option for Fbxmaya.mll in the Plug-in Manager.

10 Activate the Fbxmaya.mll Autoload option so Maya loads the Maya 
FBX plug-in automatically at start-up.

Removing the Maya FBX plug-in from Windows
1 In Maya, disable the Fbxmaya.mll Loaded and Autoload options in 

the Plug-in Manager.

2 Exit Maya.

3 Delete fbxmaya.mll from the Maya<ver>\bin\plugins directory, 
where <ver> is the version of Maya you have installed.

Macintosh installation
The Maya FBX plug-in is available for MacOS X.

1 Download the .sit file from the Autodesk web site (http://
www.Autodesk.com) to your desktop.

2 Double-click the .sit file to extract the Installation disk image.
Maya FBX Plug-in Guide
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1 | Installation
Macintosh installation
3 Double-click the package icon to start the installation. The 
Welcome pane appears (figure 1-3).

4 Click Continue to start the installation process. The Software 
License Agreement pane appears. 

5 Read the License Agreement and click Continue. A dialog box 
appears asking if you accept the terms and continue with the 
installation. 

6 Click Agree to accept. The Select a Destination pane appears. 
Select the destination disk where you want install the Maya FBX 
plug-in and click Continue. 

7 The Easy Install pane appears. Click Upgrade. 

figure 1-3: Mac installation Welcome pane.

figure 1-4: Terms of Software License Agreement dialog box,
Maya FBX Plug-in Guide
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1 | Installation

Macintosh installation
8 A dialog box appears asking you to enter your name and login 
password to continue the installation.

9 The installation begins. A progress bar indicates the time 
remaining of the installation. When the progress reaches 100%, 
the Finish Up pane appears. 

10 Click Close to exit the installation program.

11 Start Maya and navigate to Window > Settings/Preferences > Plug-
in Manager.

Note You must obtain administrator privileges to 
continue installation.

Note The Maya FBX plug-in is installed in the following 
directory: <Macintosh Drive>/Applications/Alias/
maya<ver>/Maya.app/Contents/MacOS/plug-ins, 
where <ver> is the version of Maya you have 
installed.

figure 1-5: Finish Up pane.
Maya FBX Plug-in Guide

5



1 | Installation
Linux installation
12 Activate the Loaded option for Fbxmaya.lib in the Plug-in Manager.

13 Activate the Fbxmaya.lib Autoload option so Maya loads the Maya 
FBX plug-in automatically at start-up.

Removing the Maya FBX plug-in from Mac OS X
1 In Maya, deactivate the fbxmaya.lib Loaded and Autoload options 

in the Plug-in Manager.

2 Exit Maya.

3 Locate the fbxmaya.lib plug-in. This file is found in the <Macintosh 
Drive>/Applications/Alias/maya<ver>/Maya.app/Contents/
MacOS/plug-ins directory, where <ver> is the version of Maya you 
have installed.

4 Delete the fbxmaya.lib file.

Linux installation
1 Download the installation file from the Autodesk web site (http://

www.Autodesk.com).

2 Remove the old plug-in from the /usr/aw/maya<ver>/bin/plug-ins/ 
(where <ver> is the version of Maya you have installed,) directory 
by entering % rm –f fbxmaya*.so at the command prompt.

3 Type the following command to install the Maya FBX plug-in:

% FBX<ver>_MAYA_LINUX_ENU
(Where FBX<ver> is the version of the Maya FBX plug-in you have 
installed.)

The plug-in is installed to the following directory:

/usr/aw/maya<ver>/bin/plug-ins/ (where <ver> is the version of 
Maya you have installed). 

If Maya is installed in another folder, you can specify the path on 
the command line after FBX<ver>_MAYA_LINUX_ENU /home/maya/
mypath/
Maya FBX Plug-in Guide
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1 | Installation

Linux installation
(Where FBX<ver> is the version of the Maya FBX plug-in you have 
installed.)

4 Start Maya and navigate to Window > Settings/Preferences > Plug-
in Manager.

5 Activate the Loaded option for Fbxmaya.so in the Plug-in Manager.

6 Activate the Fbxmaya.so Autoload option so Maya loads the Maya 
FBX plug-in automatically at start-up.

Removing the Maya FBX plug-in from Linux
1 In Maya, deactivate the fbxmaya.so Loaded and Autoload options in 

the Plug-in Manager.

2 Exit Maya.

3 Log into your system as root.

4 Remove the Maya FBX plug-in by entering the following command:

%rm –f /usr/aw/maya<ver>/bin/plug-ins/fbxmaya.so
Maya FBX Plug-in Guide

7



1 | Installation
Linux installation
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2 Importing and 
Exporting
This section describes how to export scenes from Maya using the .fbx 
file format and how to import them back into Maya.

It also includes a list of the Maya features supported by this version of 
the Maya FBX plug-in, as well as a list of improvements and 
enhancements for this version.

Exporting from Maya to an .fbx file

1 Open the scene that you want to save as an .fbx file in Maya.

2 Select File > Export All or File > Export Selection. A file browser 
appears. 

3 Select Fbx as the file type.

4 Use the file browser to locate the destination for your exported .fbx 
file.

5 Type the name of the .fbx file in the File Name field, and click Ok.

Note To increase the export speed, trim insignificant 
weights on deformed models with Maya’s Skin > 
Edit Smooth Skin > Prune Small Weights 
command.

Note When you create Blend Shapes in Maya, set the 
Timeline to the first frame, especially if there is 
animation. The Blend Shapes must be set to zero 
before export.
Maya FBX Plug-in Guide
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2 | Importing and Exporting
Exporting from Maya to an .fbx file
The FBX Exporter window appears (figure 2-1). Select the options 
that apply to your scene. 

For more information about the FBX Exporter window options, see 
"FBX Exporter window options" on page 11.

6 Click Export. The exporter window shows the progress of the export 
process.

7 Open the file in MotionBuilder or another 3D package.

8 If you are using MotionBuilder, when you are finished, merge the 
animation from all layers with the Base layer using the Layers pane 
in the FCurves window.

Note Read "What’s not supported in the Maya FBX plug-
in" on page 32 for a list of elements that may not 
export correctly.

figure 2-1: FBX Exporter window
Maya FBX Plug-in Guide
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2 | Importing and Exporting

FBX Exporter window options
FBX Exporter window options
Once you select an .fbx file to export from Maya, the FBX Exporter 
window appears (figure 2-2). 

The FBX Exporter window contains the following export options:

File path
Shows the path of the file selected for export.

Coordinates and Unit Conversion area
This section lets you specify the world space in which your scene is 
exported. 

figure 2-2: FBX Exporter window
Maya FBX Plug-in Guide
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2 | Importing and Exporting
FBX Exporter window options
The plug-in reads the World Coordinate System and/or the Scale 
Working units from the current scene settings and converts them to 
the specified space. The specified values are saved in the .fbx file as 
global settings for the scene. 

Conversion Method
Use the Conversion Method menu to select from one of the following 
conversion methods:

World Coordinate System Up Axis
Use this menu to define the up axis in your .fbx file. The up axis is the 
global axis that is pointing upwards. By default, Maya’s up axis is the 
Y axis.

There are two choices: 

Option Function

None No conversion takes place and the 
exported data is unaffected.

Convert animation Recalculates all animation FCurves 
so their values reflect the new World 
system.

Add FBX_Root node Adds a transformation node to the 
top of the scene to contain the 
transformations needed to transport 
the data into the new World system. 

This option facilitates backward 
compatibility as it generates the .fbx 
file the same way as earlier releases 
of the plug-in.

Note: If the plug-in does not detect a 
need for the conversion, no Fbx_Root 
node is added.
Maya FBX Plug-in Guide
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2 | Importing and Exporting

FBX Exporter window options
Y-axis

Z-axis

The default for this setting is Y.

Scale working units
This area lets you set the unit of measurement you want to use in your 
file.

1 cm will become

Use the 1 cm will become menu to specify the units of the scene 
saved in the .fbx file from a list of commonly-used unit conversions.

By default, the plug-in offers no conversion, that is, 1 centimeter 
remains 1 centimeter.

Scale factor
Defines a global scale that affects the entire scene. 

Rotation curves using quaternion interpolation
Lets you select options for the export of Rotation curves. Activate any 
of the following options to set how the plug-in processes Rotation 
curves:

Option Function

Retain quaternion interpolation Transfers quaternion interpolation 
flags to Maya’s FCurves whenever 
the Maya FBX plug-in encounters 
rotation curves marked to be 
interpolated.
Maya FBX Plug-in Guide
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2 | Importing and Exporting
FBX Exporter window options
Apply Constant Key Reducer filtering
Deletes any redundant keyframes. This removes keyframes or keys 
that have the same value, which are the same as the flat sections of 
an FCurve.

Resampling frame rate (fps)
Sets the rate that the FBX Exporter produces keyframes when it needs 
to resample data. 

Resampling is used when the interpolation of the Maya animation 
curve cannot be accurately represented by curves in MotionBuilder. 

Export animation only
Activate this option to exports any animation in your scene. 

Set as Euler interpolation Does not transfer quaternion 
interpolation flags to Maya’s 
FCurves, and instead interpolates 
the FCurves in Euler space whenever 
the Maya FBX plug-in encounters 
rotation curves marked for 
interpolation.

Resample as Euler interpolation Resamples rotation curves in the 
quaternion space and transfers the 
resulting curves to Maya as Euler 
curves. 

Use this method if you are 
experiencing problems with 
quaternion curves inside Maya.

This is the default setting.

Option Function
Maya FBX Plug-in Guide

14



2 | Importing and Exporting

FBX Exporter window options
When you activate this option, the plug-in ignores any non-animated 
objects and replaces all animated objects with NULL objects, creating 
a smaller file containing animation but no geometry, lights, or 
cameras. 

Split mesh for per-vertex normals
Activate this option for the .fbx file to support normal per-polygon 
vertices. It duplicates the vertices at the polygons, creating the effect 
of hard edges.

Export Edge Smoothing
When this option is active, the plug-in exports the required information 
for identifying edges that are defined as hard or smooth. This option 
does not duplicate the vertices as is done by the Split Mesh for per-
vertex normals option. 

This setting is active by default.

Export Blind Data
Blind Data is information stored with polygons that is not used by 
Maya in any way, but is useful to the platform to which the polygons 
are exported, such as a games engine. 

Activate this option if you want to save any Blind Data stored with the 
polygons so that it will be available for later use.

Export constraints
Activate this option to include all constraints in the file on export.

Note This option was previously named Export hard 
edges.
Maya FBX Plug-in Guide
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2 | Importing and Exporting
FBX Exporter window options
When this option is disabled, the export process ignores all the 
constraints defined in the Maya scene and does not include them in 
the .fbx file. 

The default setting is active.

Export character definition
Activate this option to include character definition in the file on export. 

When this option is disabled, the character definition in the Maya 
scene does not export to the .fbx file. 

Embed textures
Activate this option to copy the texture and material files associated 
with the file into the .fbx file, so that they are not referred to from the 
hard disk.

Convert to portable format (TIFF)
Activate this option to convert textures into .tiff format, which makes 
them readable on other platforms. 

Export to ASCII format
Activate this option to save the .fbx file in ASCII format.

Bake complex animation
Evaluates the animation of objects that are not directly supported, 
such as Handles, Expression constraints, and so on. This is done 
between the frames specified in the Start and End fields. 

Baking the animation increases portability between 3D packages.
Maya FBX Plug-in Guide
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FBX Exporter window options
Set the following parameters:

Export Quick Select Set as Geometry Cache file(s)
Creates a cache file for the Quick Select Set that to be referenced by 
the .fbx file so that the Quick Select Set is available after conversion.

Three files are generated when you activate this option:

an .fbx file, 

an .xml file 

a .mc file 

The .xml and .mc files are stored in a sub-folder that is named for the 
.fbx file and has the extension .fpc.

For example, if you export a scene containing a cube named pCube1 to 
the .fbx file myTest.fbx, you create the following files:

myTest.fbx

myTest.fpc

Parameter Function

Start The first frame to be evaluated. All 
animation before the start frame is 
not included in the baked file.

End The last frame to be evaluated. All 
animation after the End frame is not 
included in the baked file. 

When you click Export, the scene is 
baked from the Start time until the 
End time. 

Step The increment used when baking the 
animation between the Start and End 
times.
Maya FBX Plug-in Guide
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FBX Exporter window options
pCubeShape1.xml

pCubeShape1.mc

Export Quick Select Set menu
Choose a set from the list.

Export to version
Exports your file to a legacy .fbx file format. 

Expand the Version menu to choose a different .fbx version. See "FBX 
Versions" on page 20 for more information about each different .fbx 
file format version.

Export NURBS surfaces as
This option lets you choose how the plug-in exports NURBS surfaces. 
Select from the 3 options:

Note This option is only available with the plug-in for 
Maya 8.0. 

Note This item is available only if the Export Quick 
Select Set as Geometry Cache file(s) option is 
active.

Option Function

NURBS NURBS surfaces are not converted 
and their definition is stored in the 
.fbx file.
Maya FBX Plug-in Guide
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FBX Exporter window options
Show the Warnings and Errors dialog box
Lets you disable the Warnings and Errors dialog box that may appear 
during the import/export process. 

The default setting is Active.

Export 
Starts the export process.

Reset
Restores the FBX Exporter window’s default values.

Cancel
Closes the FBX Exporter window without performing any action.

Check for web updates
Opens a browser window and searches the Autodesk web site for 
newer versions of the plug-in.

Interactive display mesh NURBS surfaces are converted to a 
mesh object (tessellated) using the 
values that best imitate the 
interactive display settings.

Software render mesh NURBS surfaces are converted to a 
mesh object (tessellated) with the 
same resolution used by the 
software renderer.

Option Function
Maya FBX Plug-in Guide
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FBX Exporter window options
Help
Accesses the Maya FBX Plug-in Guide (in .pdf format).

FBX Versions
The following table lists the different versions available for you to 
select from the Export to version menu in the FBX Exporter window.

Version Description

FBX200611 Select this version to use your file 
with the latest version of the Maya 
FBX plug-in (for example, version 
FBX200611).

Note: Do not use this version to 
export from Maya into MotionBuilder 
7.5. Use the FBX200602_MB75.

FBX200608 Select this version to use your file 
with the 200608 version of the Maya 
FBX plug-in.

Note: Do not use this version to 
export from Maya into MotionBuilder 
7.5. Use the FBX200602_MB75.

FBX200602_MB75 Select this version to use your file 
with MotionBuilder 7.5 and its 
associated plug-ins (for example, 
version FBX200602).

Note: Use this option to export Maya 
files into MotionBuilder 7.5. 
Otherwise, NURBS are lost and 
mesh normals may be inverted.

In this mode, normals in normal per 
polygon/vertex mode are transformed 
to normals per vertex and hard edges 
become smooth edges.
Maya FBX Plug-in Guide
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Importing .fbx files into Maya
Importing .fbx files into Maya
The following procedure is for importing an .fbx file into Maya.

Files remain backward compatible, for example, a file saved with 
FBX53_MB55 can be read by applications supporting FBX60_MB60, 
FBX200508_MB70 and FBX200602_MB75.

To import an .fbx file into Maya:

1 In Maya, select File > Import. A file browser appears.

2 Select Fbx as the file type.

3 Locate the .fbx file that you want to import. 

FBX200508_MB70 Select this version to export into a 
format that can be read by 
MotionBuilder 7.0 and its associated 
plug-ins (for example, version 
FBX200508).

FBX60_MB60 Select this version to export into a 
format that can be read by 
MotionBuilder 6.0 and its associated 
plug-ins).

FBX53_MB55 Select this version to export into a 
format that can be read by 
MotionBuilder 5.5 and its associated 
plug-ins).

Note If you do not select .fbx as the file type, MAC OS X 
systems runs the image viewer “Check” program 
instead of loading the file.

Version Description
Maya FBX Plug-in Guide
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Importing .fbx files into Maya
The FBX Importer window appears (figure 2-3).

4 Activate any options that you want applied to your scene. 

For information about the options in the FBX Importer window, see 
"FBX Importer window options" on page 23.

5 Click Import.

Note Read "What’s not supported in the Maya FBX plug-
in" on page 32 for a list of elements that may not 
import correctly.

figure 2-3: FBX Importer window
Maya FBX Plug-in Guide
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FBX Importer window options
FBX Importer window options
Once you select an .fbx file to import into Maya, the FBX Importer 
window appears (figure 2-4). 

The FBX Importer window contains the following import options:

File path
Shows the path of the file selected for import.

Take
Displays the takes included in the scene. Click a take to select it for 
import. 

Note You can only select one take at a time.

figure 2-4: FBX Importer window
Maya FBX Plug-in Guide
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FBX Importer window options
Rotation curves using quaternion interpolation
Lets you select options for the import of Rotation curves. Activate any 
of the following options to set how the plug-in treats Rotation curves:

Option Function

Exclusive merge Transfers animation into nodes that 
exist in both the current Maya scene 
and the .fbx file. 

No new nodes are created.

Add to new scene Imports your data into a new scene.

Merge Merges the imported .fbx file to the 
current scene by creating any node 
without its equivalent in the scene. 

Nodes with the same name but not 
of the same nature, for example, 
sphere and bone, are replaced. 

Nodes with the same name and 
nature have only their animation 
replaced.

This is the default setting.

Option Function

Retain quaternion interpolation Transfers quaternion interpolation 
flags to Maya’s FCurves whenever 
the Maya FBX plug-in detects rotation 
curves marked to be interpolated.

Set as Euler interpolation Does not transfer quaternion 
interpolation flags to Maya’s 
FCurves, and instead interpolates 
the FCurves in Euler space whenever 
the Maya FBX plug-in detects rotation 
curves marked to be interpolated.
Maya FBX Plug-in Guide
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FBX Importer window options
Coordinate and Unit Conversion
This section lets you specify the world space in which your scene is 
imported. 

The plug-in processes the conversions of the World Coordinate System 
and/or the Scale Working units defined in the .fbx file, as well as the 
options you set. 

Convert incoming World coordinate to
Activate this option so you can use the menu to select a Y- or Z-up axis 
convention for the import of your file.

If this option is disabled, the menu is grayed out and displays the 
current Maya world coordinate setting. 

World Coordinate System Up axis
Use this menu to define the up axis in your .fbx file. The up axis is the 
global axis that is pointing upwards. By default, Maya’s up axis is the 
Y axis.

Resample as Euler interpolation Resamples rotation curves in the 
quaternion space, and transfers the 
resulting curves to Maya as Euler 
curves. 

Use this method if you are 
experiencing problems with 
quaternion curves inside Maya.

This is the default setting.

Note This conversion affects only the incoming data. 
Maya’s settings are not changed. 

Option Function
Maya FBX Plug-in Guide
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FBX Importer window options
There are two choices:

Y-axis

Z-axis

The default setting is Y.

Scale Working Units
Activate this option so you can specify units to import data from the 
.fbx file. Use the 1 cm will become list to choose from commonly-used 
conversion units.

Convert to

Use the Convert to menu to specify the units of the scene saved in the 
.fbx file from a list of commonly-used unit conversions.

By default, the plug-in offers no conversion, that is, 1 centimeter 
remains 1 centimeter. 

Scale factor

Defines a global scale that affects the entire scene. 

Detected destination frame rate
Shows Maya’s current frame rate. 

Use FBX file frame rate in Maya
Activate this option to import the frame rate from the .fbx file. This 
overwrites the rate used in Maya.

Use resampling frame rate from
Lets you choose a resampling frame rate for the plug-in to use when it 
resamples FCurves.
Maya FBX Plug-in Guide
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FBX Importer window options
Choose from the following options:

Resampling frame rate (fps)
Sets the rate at which the importer produces keyframes when it needs 
to resample data. 

Resampling is needed when the interpolation of the Maya animation 
curve cannot be perfectly represented by curves in MotionBuilder.

Pre-normalize weights
Activate this option if you notice unusual skin weighting, as this option 
forces the .fbx file’s weights to conform to Maya’s conventions.

Depending on the size of your scene, this process may take several 
minutes.

Import constraints
Imports all constraints into the new scene.

When this option is disabled, all the constraints defined in the .fbx file 
are ignored by the importing process and are not present in the Maya 
scene.

Option Function

Maya (default) Retains Maya’s current frame rate.

FBX Changes Maya’s frame rate to the 
one specified in the .fbx file.

Custom Activates the Resampling Frame 
Rate field.
Maya FBX Plug-in Guide
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FBX Importer window options
The default setting is active.

Import character definition
Imports Character Definitions into the scene.

When this option is disabled, the Character definition in the .fbx file is 
not imported into the Maya scene.

Convert incoming deforming nulls to joints
Converts deforming nulls into Maya bones. 

This option was originally provided because Maya did not support null 
elements (that is, transform nodes that are not joints,) within a bone 
hierarchy). 

While Maya now supports this, in some cases using this option 
improves the skinning behavior.

Merge Pivot nodes as Rotate axis and joint orient
Activate this option only when you use older .fbx files.

Assigns the rotation transformation of the null (or joints) elements in 
the hierarchy that are used as pre- and post-rotation to the joint orient 
and the rotate axis of the original node. 

The pre-rotation and post-rotation nodes are then deleted. Older files 
created with the Export Pre/Post Rotation as Nulls option are merged 
back to the original Maya setup.

Note When using Exclusive Merge or Merge, activating 
this option does not import constraints.
Maya FBX Plug-in Guide
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FBX Importer window options
Combine mesh for per-vertex normals
Activate this option to merge vertex duplication previously created by 
the Export option Split mesh for per vertex normals. See "Split mesh 
for per-vertex normals" on page 15.

Import Edge Smoothing
When this option is active, the plug-in exports the required information 
for identifying edges that are defined as hard or smooth and sets the 
polygon edges with the saved state. 

If you disable this option, these states are discarded and Maya 
recomputes the normals with internal algorithms. All hard edges are 
lost.

This setting is active by default.

Import blind data
Blind Data is information stored with polygons that is not used by 
Maya in any way, but is useful to the platform to which the polygons 
are exported, such as a games engine. 

Activate this option if you want to save any Blind Data stored with the 
polygons so that it will be available for later use.

Protect driven keys
Prevents any channels with driven keys from being overwritten by the 
incoming animation.

Note This option was previously named Import hard 
edges.
Maya FBX Plug-in Guide
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FBX Importer window options
Merge animation layers
Computes the effect of all animation layers and transfers the resulting 
animation to Maya whenever multiple layers of animation are used.

Import Geometry Cache file(s)
Loads cache file(s) referenced by the .fbx file.

Show the Warnings and Errors dialog box
Lets you disable the Warnings and Errors dialog box that may appear 
during the import/export process. 

The default setting is Active.

Import 
Begins the import process.

Reset
Restores the FBX Importer window’s default values.

Cancel
Closes the FBX Importer window, without performing any action.

Check for web updates
Opens a browser window and searches the Autodesk web site for 
newer versions of the plug-in.

Note This option is only available with the plug-in for 
Maya 8.0.
Maya FBX Plug-in Guide
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What’s supported in the Maya FBX plug-in
Help
Accesses the Maya FBX Plug-in Guide in .pdf format.

What’s supported in the Maya FBX plug-in
The Maya FBX plug-in supports the following Maya functionalities:

Texture maps 

Collada format (beta-level support only). When exporting from 
Collada to .fbx format, use the Y-Axis option from the World 
Coordinate System Up Axis menu and the Add FBX_Root node 
option from the Conversion Method menu.

Maya Point, Orient, Scale, Parent, Chain IK, Aim and Character 
constraints.

Full Body IK.

NURBS and Polygons.

Skeletons.

Cluster deformations, Smooth and Rigid bindings

User attributes.

Plateau interpolation.

COLLADA format now supports texture channels.

File textures.

Texture mapping is converted as UV Maps. Texture placement and 
rotation is supported. Image maps on all channels. 

Expressions, Driven Keys and Constraints. 

Supported, but with a conversion. You must bake on export. See 
"Bake complex animation" on page 16.

Pivots.

Lights.
Maya FBX Plug-in Guide
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What’s not supported in the Maya FBX plug-in
Intensity value, animation, as well as color value and animation 
are supported.

Cameras.

Squeeze ratio, Near and Far plane values, Aperture width, Height, 
FOV, and Focus Length.

Phong and Lambert standard materials are supported directly with 
no conversion. Blinn materials are converted to Phong.

Light property Decay rate and Decay start settings for light 
properties and near/far attenuation.  

Blend Shape deformations.

Supported, provided that the target(s) are not deleted. Blend 
shape weights are ignored on export, and remain unchanged on 
import. 

What’s not supported in the Maya FBX plug-
in
The Maya FBX plug-in does not support the following Maya features:

Procedural textures. 

Deformers.

Note The Maya FBX plug-in stores the near/far 
attenuation as dynamic attributes on the light 
nodes to preserve them during the import and 
export process.

Note The Maya FBX plug-in only supports Blend Shapes 
that have a “Deformation Order” that is upstream, 
that is, Before, FrontOfChain or Default.
Maya FBX Plug-in Guide
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What’s new
Deformers other than clusters, or Smooth or Rigid binding, are not 
supported.

Subdivs.

Curves.

Curves show up as nulls (locators) in MotionBuilder. 

Groups. 

Parent geometry instead.

Use File Textures and Polygon projections.

Bake (Hypergraph>Convert to File Textures) any procedural 
textures (Grid, Ramp, and so on) that have a UV rotation (Place 2D 
texture node). 

In MotionBuilder the UV rotation has a corner pivot instead of 
Maya’s center pivot. 

What’s new
The following section contains the new features, bug fixes, and known 
limitations for this version of the Maya FBX plug-in:

New features
This version of the Maya FBX plug-in contains many enhancements 
intended to optimize the transfer of files. These improvements 
have been made to further stabilize and improve the behavior of 
the previous version (200608) of the plug-in. 

Added support for image maps on all channels on import and 
export. 
Maya FBX Plug-in Guide
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Known limitations
Support for Decay rate and Decay start settings for light 
properties, as well as near/far attenuation.  

The Maya FBX plug-in is compatible for export to the 2006.11 
version.

Import and export to COLLADA format now supports texture 
channels.

Bug fixes
A problem with exporting to .dxf format (DXF_FBX) where object 
names caused a “Invalid or incomplete DXF input” error has been 
corrected.

Textured layers are now are added in the correct order.

The plug-in now correctly supports pre/post-infinity attributes on 
Maya animation curves.

A problem involving the CV weighting export/import/write of 
NURBS has been fixed.

A connection bug involving Transparency has been fixed.

Problems with the display of optical marker locators have been 
resolved.

You can now export multiple regions on a trim surface.

Known limitations
This section lists the known limitations of the Maya FBX plug-in:

Note The Maya FBX plug-in stores the near/far 
attenuation as dynamic attributes on the light 
nodes to preserve them during the import and 
export process.
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Known limitations
Instanced geometry incorrectly exported. When exporting scenes 
with instanced geometry, the geometry is duplicated but is 
parented under the original's parent, creating incorrect positioning. 

Bump texture Depth values not saved. The Maya FBX Plug-in does 
not retain Bump texture Depth values on import or export, and 
resets all Depth values to 1 on export regardless of their original 
value. 

You may encounter memory issues when using large architectural 
scenes. If this problem occurs, keep the scene minimal and try to 
avoid an excessive polygon count.

Currently a limitation exists where Blinn materials are converted to 
Phong.

The Visibility FCurve adjusts itself to contain a value of only 0 or 1. 
Also the FCurve is converted to Constant (step) interpolation. 
Therefore, any value above 0 is considered as 1 (visible) and any 
value below or equal 0 is considered 0 (invisible).

When exporting, if the Tangent type is Slow or Fast, the Maya FBX 
plug-in resamples FCurves. They are also resampled if the 
OutTangent is Linear and the InTangent is different, or the 
OutTangent is Flat, Smooth, or Fixed and the InTangent is not Flat, 
Smooth or Fixed.

Nurbs display precision is supported and exported as StepU and 
StepV parameters in MotionBuilder. Both U and V are assigned the 
same value; as in Maya, its value is unique. Values of the 
Precision parameters are clamped to a maximum of 15 (the 
software’s limit).

Maya's Ambient Area and Volume lights are not supported.

Note When importing, the larger value between StepU 
and StepV is used.
Maya FBX Plug-in Guide
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Known limitations
The Maya FBX plug-in is only capable of processing upstream 
Blend Shape deformers. Default mode is supported but In-Between 
and Global modes are not.

A renaming strategy is used when there are multiple instances of 
the same name in a scene, as well as any Upper/Lower case 
conflicts. See "Renaming strategy" on page 36 for details on how 
this renaming is applied.

Renaming strategy
When the Maya FBX plug-in discovers objects or elements that have 
the same name, a naming conflict occurs. The plug-in compensates for 
this by renaming the elements on import or export. The same is true 
for any upper- and lower-case conflicts.

The following is a description of what happens:

Redundant names
When the Maya FBX plug-in finds multiple instances of the same name 
in the scene, a symbolic code is used. The Maya FBX plug-in can read 
older files, although it no longer writes them this way. 

The new suffix is then:  _ncl1_x (where x is the instance number). 

Case conflicts

When the Maya FBX plug-in finds upper- and lower-case conflicts in the 
names of objects or elements in the scene, a more complex suffix is 
used to keep track of which character was/is upper- or lower-case so it 
can be converted back on import/merge. 

The following suffixes are used to indicate the case:

Situation Suffix

Indicates case _ncl2 
Maya FBX Plug-in Guide
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Known limitations
To depict characters that were 
originally upper case and have 
become lower case

_ulXXXX 

To depict characters that were 
originally lower case and have 
become upper case

_luxxxx

Where xxxx is a four-digit integer 
representing the character position 
in the string (bit-wise).

For example, _ul5 indicates that the 
first and third characters in the string 
have been changed from upper to 
lower case. A suffix can be made of 
the combination of _ul and _lu sub-
suffixes.

Situation Suffix
Maya FBX Plug-in Guide
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Known limitations
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3 Maya MEL Scripting
This section contains scripts required for scripting with Maya MEL 
commands.

All of the Maya FBX plug-in's MEL commands begin with the FBX prefix. 
When error conditions are encountered, they will display error 
messages in the Script Editor window. The MEL commands that are 
registered by the Maya FBX plug-in are listed in the Plug-in Manager 
information dialog box.

FBXExport -f [filename]
Exports the specified file. If FBXExportShowUI is True, the Export dialog 
box is shown.

FBXExportShowUI -v [true|false]

True
Displays the Export dialog box each time user clicks File > Export or 
uses the FBXExport MEL command.

False
Never displays the Export dialog box. The only way to have the Export 
dialog box displayed again is to set this flag to True by using this MEL 
command or by checking the appropriate check box in the Batch dialog 
box.

Note To use the following MEL commands, the Maya 
FBX plug-in must be installed on your computer.
Maya FBX Plug-in Guide
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FBXExportHardEdges -v [true|false]
FBXExportHardEdges -v [true|false]
Duplicates all vertices in the scene's meshes for each polygon 
connected to them. The vertices’ normals are set accordingly, 
depending on whether they are connected to a hard or smooth edge.

If two vertices are located exactly at the same position, a warning is 
issued, as this causes unpredictable results when 
FBXImportHardEdges is set to True.

This command is the script version of the FBX Exporter window’s Split 
mesh for per Vertex Normals option. See "Split mesh for per-vertex 
normals" on page 15.

FBXExportConstraints -v [true|false]
Causes all the constraints defined in the Maya scene to be ignored by 
the exporting process, and excluded from the .fbx file.

FBXExportCharacter -v [true|false]
Causes the export of Character definition in the Maya scene to be 
excluded from the .fbx file.

FBXExportApplyConstantKeyReducer -v 
[true|false]

True
Filters FBX animation FCurves through a Constant Key reducer. This 
eliminates constant keys on a FCurve and helps to reduce the size of 
resampled FCurves, especially Scale.

Note This function allows MotionBuilder to display hard 
edges.
Maya FBX Plug-in Guide
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FBXExportEmbeddedTextures -v [true|false]
False
Setting this command to False ensures that the animation data is not 
filtered.

FBXExportEmbeddedTextures -v [true|false]

True
Saves all textures in the .fbx file. This command performs the same 
action as the Embed Textures option in the FBX Exporter window.

FBXExportQuaternion -v 
[quaternion|euler|resample]
This command has the same definition as the FBXImportQuaternion 
but works in the reverse.

FBXExportBakeComplexAnimation -v 
[true|false]
This command is the script equivalent of the Bake complex animation 
option. See "Bake complex animation" on page 16.

FBXExportBakeComplexStart -v int
This command is the script equivalent of the Bake complex animation 
option’s Start field. The passed value is an integer number. See 
"Start" on page 17.
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FBXExportBakeComplexEnd -v int
FBXExportBakeComplexEnd -v int
This command is the script equivalent of the Bake complex animation 
option’s End field. The passed value is an integer number. See "End" 
on page 17.

FBXExportBakeComplexStep -v int
This command is the script equivalent of the Bake complex animation 
option’s Step field. The passed value is an integer number. See 
"Step" on page 17.

FBXResetExport
This command is the script equivalent of the FBX Exporter window’s 
Reset button. See "Reset" on page 19.

FBXExportAxisConversionMethod 
[none|convertAnimation|addFbxRoot]
This command is the script version of the FBX Exporter window’s 
Conversion Method menu. See "Conversion Method" on page 12.

FBXExportUpAxis [y|z]
This command is the script version of the FBX Exporter window’s 
Convert Incoming World Coordinate system Up axis menu. See "World 
Coordinate System Up axis" on page 25.

FBXExportScaleFactor value 
(Where value is a float number.)

This command is the script version of the FBX Exporter window’s Scale 
Factor field. See "Scale factor" on page 13.
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FBXConvertUnitString [mm|cm|m|km|in|ft |yd|mi]
FBXConvertUnitString [mm|cm|m|km|in|ft 
|yd|mi]
This command returns the scale factor required to convert one cm to 
the specified unit and is the script version of the 1cm will become 
menu in the FBX Exporter and Importer windows. 

FBXExportCacheFile –v [true|false]
This command is the script version of the FBX Exporter window’s 
Export Quick Select Set as Geometry Cache file option. See "Export 
Quick Select Set as Geometry Cache file(s)" on page 17.

FBXExportEdgeSmoothing –v [true|false]
This command is the script version of the FBX Exporter window’s 
Export Edge Smoothing option. See "Export Edge Smoothing" on 
page 15.

FBXExportQuickSelectSetAsCache –v 
“setName”
This command stores the setName as the set to be used when 
exporting the cache file. 

This command does not validate the received string. However, if the 
string used here does not correspond to an existing (and valid) set in 
the Maya scene, the cache export fails.

FBXExportQuickSelectSetAsCache –q 
This command returns the current set name as defined by the last call 
to FBXExportQuickSelectSetAsCache. See 
"FBXExportQuickSelectSetAsCache –v “setName”" on page 43.
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FBXImportAxisConversionEnable –v [true|false]
FBXImportAxisConversionEnable –v 
[true|false]
This command is the script version of the FBX Importer window’s 
Convert Incoming World Coordinates to option. See "Convert incoming 
World coordinate to" on page 25.

FBXImportScaleFactorEnable –v [true|false]
This command is the script version of the FBX Importer window’s Scale 
Working units option. See "Scale working units" on page 13.

FBXImportScaleFactor value
(Where value is a float number.)

This command is the script version of the FBX Importer window’s Scale 
Factor menu. See "Scale factor" on page 26.

FBXImportUpAxis [y|z]
This command is the script version of the FBX Importer window’s World 
Coordinate system up axis menu. See "World Coordinate System Up 
axis" on page 25.

FBXImportEdgeSmoothing –v [true|false]
This command is the script version of the FBX Importer window’s 
Import Edge Smoothing option. See "Import Edge Smoothing" on 
page 29.
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FBXImportCacheFile –v [true|false]
FBXImportCacheFile –v [true|false]
This command is the script version of the FBX Importer window’s 
Import geometry Cache file(s) option. See "Import Geometry Cache 
file(s)" on page 30.

FBXImport -f [filename] -t [take index]
Imports the specified file. If FBXImportShowUI is True, the Import 
dialog box is shown.

The file imported is the one accessible for take querying after the 
execution of the command.

FBXImportShowUI -v [true|false] 
Once FBXImportShowUI is set to False, the user interface does not 
appear until FBXImportShowUI is set to True. 

There are two possible states:

True
Shows the Import dialog box each time you click File > Import or use 
the FBXImport MEL command.

False
Hides the Import dialog box. The only way to show the Import dialog 
box again is to set this flag to True with this MEL command or by 
checking the corresponding check box in the Batch dialog box.
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FBXImportHardEdges -v [true|false]
FBXImportHardEdges -v [true|false]
Merges back all vertices located at the same exact position as a 
unique vertex. The Maya FBX plug-in then determines if the edges 
connected to each vertex are hard edges or smooth edges, based on 
their normals.

Use this function when FBXExportHardEdges is set to True on export.

This command is the script version of the FBX Importer window’s 
Combine Mesh for per Vertex Normals option. See "Combine mesh for 
per-vertex normals" on page 29.

FBXImportConstraints -v [true|false]
Causes all constraints defined in the .fbx file to be ignored by the 
importing process and excluded from the Maya scene.

FBXImportCharacter -v [true|false]
Causes the import of the Character definition in the .fbx file to be 
excluded from the Maya scene.

FBXImportMergeBackNullPivots -v 
[true|false]

True
Assigns the rotation transformation of the null (or joints) elements in 
the hierarchy that are used as pre-rotation and post- rotation to the 
joint orient and the rotate axis of the original node. 

The pre-rotation and post-rotation nodes are then deleted.

The look-up is done by name as the pre-rotation node's name contains 
the “__Pre_ “suffix, while the post-rotation node's name has a 
“__Post_” suffix.
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FBXImportConvertDeformingNullsToJoint -v [true|false]
Use this function only when the scene was exported using the 
FBXExportReplacePivotsByNulls script set to True.

FBXImportConvertDeformingNullsToJoint -v 
[true|false]
Converts deforming nulls into Maya bones. 

True
Transforms all null elements into joint nodes.

FBXImportMode -v [exmerge|add|merge]
This command has three possible states:

Exmerge
Merges the imported .fbx file to the current scene in the following way: 

Nodes of the same name and nature have only their animation curve 
replaced. No new nodes are created.

Add
Creates a new scene prior to the file import. 

Note When the import mode is set to Exmerge or Merge 
this option is automatically set to True.

Note This option was originally provided because Maya 
did not support null elements (that is, transform 
nodes that are not joints,) within a bone hierarchy.

While Maya now supports this, in some cases this 
option improves the skinning behavior.
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FBXImportOverrideNormalsLock -v [true|false]
Merge
Merges the imported .fbx file to the current scene in the following way: 
any node without its equivalent in the scene is created. Nodes with the 
same name but not of the same nature, for example, sphere and 
bone, are replaced. Nodes with the same name and nature only have 
their animation replaced.

FBXImportOverrideNormalsLock -v 
[true|false]
Overrides the default Maya locking of normals. 

True
Recomputes the normals on the objects using Maya internal 
algorithms.

FBXImportQuaternion -v 
[quaternion|euler|resample]
Lets you specify how quaternion rotations should be treated on import 
into Maya. This option compensates for differences between Maya 
quaternions and MotionBuilder quaternions. 

FBXImportResamplingRateSource -v 
[Maya|FBX|Custom]
This command is the script equivalent of the Use resampling frame 
rate from option. See "Use resampling frame rate from" on page 26.

FBXImportSetMayaFrameRate -v [true|false]
This command is the script equivalent of the Use FBX file frame rate in 
Maya option. See "Use FBX file frame rate in Maya" on page 26.
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FBXExportConvert2Tif –v [true|false]
FBXExportConvert2Tif –v [true|false]
This command is the script version of the FBX Exporter window’s 
Convert to portable format (TIFF) option. See "Convert to portable 
format (TIFF)" on page 16.

FBXResetImport
This command is the script equivalent of the FBX Importer window’s 
Reset button. See "Reset" on page 30.

FBXRead -f [filename]
Reads the specified .fbx file without importing anything into Maya. The 
file is instead stored in a buffer. This command is used for take 
querying. 

Once read or imported, use the commands FBXGetTakeCount, 
FBXGetTakeName, FBXGetTakeIndex for take querying.

FBXGetTakeCount
Returns the number of takes saved in the file stored in the file buffer. 

Load a file into the file buffer using the FBXRead command.

Note You can use this option only if the “Embed 
textures” option is enabled.

Note The file you are reading must match an existing 
file name, otherwise the file in the buffer is 
destroyed if you attempt to read or import a non-
existent file. 
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FBXGetTakeIndex [take name]
FBXGetTakeIndex [take name]
Returns the index of the first take named as the parameter in the take 
array. This command uses the file stored in the file buffer.

Load a file into the file buffer using the FBXRead command.

FBXGetTakeName [index]
Returns the name of the take at the specified index in the take array. 
This command uses the file stored in the file buffer. 

Load a file into the file buffer using the FBXRead command.

FBXGetTakeComment [index]
Returns the comment attached to the take at the specified index in 
the take array. This command uses the file stored in the file buffer. 

Load a file into the file buffer using the FBXRead command.

FBXGetTakeLocalTimeSpan [index]
Returns the local start and local stop time of the take at the specified 
index in the take array. This command uses the file stored in the file 
buffer. 

Load a file into the file buffer using the FBXRead command.

FBXGetTakeReferenceTime Span [index]
Returns the reference start and stop times of the take at the specified 
index in the take array. This command uses the file stored in the file 
buffer. 

Load a file into the file buffer using the FBXRead command.
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FBXBatchDialog
FBXBatchDialog
Displays the Batch dialog box. This box contains all the import and 
export controls displayed by the Import dialog box and the Export 
dialog box, plus a check box to enable or disable those user 
interfaces. 

The Batch Dialog box must be opened from the script editor. Since you 
must use this MEL command to disable the import/export user 
interfaces, you can call it again when you want to re-enable the import/
export user interfaces. 

FBXResamplingRate -v [float]
Sets the rate at which the exporter produces keyframes when it needs 
to resample data. 

Resampling is needed when the interpolation of the Maya animation 
curve cannot be perfectly represented by curves in MotionBuilder.

FBXCheckForWebUpdates [no arguments] 
The script version of the Check for web updates button in the Importer 
and Exporter windows. See "Check for web updates" on page 19.
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FBXCheckForWebUpdates [no arguments]
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